Handwriting

MANUAL
Letter-join is an on-line, whole school
scheme that includes everything you
need to teach handwriting.

Display Printed or Cursive
handwriting fonts to suit
your handwriting style

Lesson Planners for
printed and cursive
handwriting

Digital handwriting games
with a choice of fonts

Pupil log-in for
school and home

Worksheets for real
handwriting practice

Welcome to Letter-join
Contents

Letter-join is a whole school handwriting scheme offering
teachers the option to start teaching handwriting using
either printed or cursive letters.

Classroom set-up for teachers

The Letter-join website is continuously updated with new

4 Classroom set-up

7 Font set-up for MS Word

resources providing the most comprehensive and enjoyable

5 The Letter-join menu

38 School Administrator page

handwriting scheme for teachers and pupils. If you are new
to Letter-join, register for a free trial at www.letterjoin.co.uk

6 The 7 Letter-join fonts

Lesson
Planners

8

EYFS

10 Structured programme
to introduce handwriting
to Early Years pupils.

KS1
KS2

Designed for schools wishing to
follow a whole school approach to
handwriting.

14 Resources to teach
other character sets
and to reinforce and
practise handwriting.

20 Exercises to promote fluent
and legible handwriting
to help reach National
Curriculum expectations.

Essential Letter-join
Lesson Planner
MODULE 1

Letter-join in the classroom
Letter-join is an online handwriting resource for
teaching handwriting on interactive whiteboards. It
includes animations, touch-screen activities, cursive
and printed fonts, lesson planners and access to
hundreds of practice worksheets.

Print and Cursive

Lesson Planner
MODULES 2 & 3
Print and Cursive

Alternative letterforms
Letter-join cursive fonts include alternative
letterforms for f, k, w, x and z. The printed font has
alternative letterforms for f and k.

Cursive

Resources
30 Dictation Exercises

26 Printout sheets

32 On-line Word Processor

29 Worksheet Generator

34 Word Animator and Word Banks

School Admin & Tech
40 The School Administrator page
How to personalise Letter-join for
your school.
42 Letter-join for pupils at home
Access Letter-join at home.

43 Installing fonts
Downloading and installing
Letter-join fonts on PCs and
across networks.
43 LearnPad installation
Access Letter-join on a Learn Pad.
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Cursive

or

Printed

Letterforms and fonts to suit your handwriting policy

Letter-join practice worksheets
Letter-join contains worksheets and printouts in PDF
format. These will use your class choice of font and
your school’s preferred letterforms.

RECOMMENDED
BROWSERS

Google Chrome

Apple Safari

Letter-join on iPads and tablets
Letter-join access on iPads and tablets is included
with school subscriptions. Letter-join’s fun, touchscreen activities are compatible with most Apple,
Android and Windows tablets.
Free home access for your children
Letter-join includes free access for pupils to log in to
Letter-join at home on PCs and tablets.
Handwriting Lesson Planners
For schools wishing to follow a structured
handwriting plan, there are handwriting Lesson
Planners for all year groups. There is also a
Handwriting Assessment Tracker and Handwriting
Recovery Programme.
Handwriting Policy Document
Letter-join includes a curriculum-based Handwriting
Policy that can be personalised by schools.
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Teach handwriting

Choice of Letter-join fonts
Class teachers can choose Cursive or Printed fonts
to use for online resources and printouts. School
subscribers can download fonts to use in MS Word.

Lesson Planner
MODULES 4 to 7

24 Introduction

Recently added to Letter-join: a new printed font,
Print Plus, and linked resources for Early Years
and Key Stage 1.

Lesson Planners for cursive or printed letters

SET A TASK

Teachers can select different
Letter-join fonts for activities and
worksheets.

Font choices are auto selected
for pupils in class and at home.

Choose and print worksheets in your chosen
font for real handwriting practice.
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Classroom Set-up

CLASSROOM SET-UP

The Letter-join menu

Click on the Info button on any Letter-join web

Search here to find any
Letter-join worksheet

page for essential classroom information.

Search to find any
Letter-join worksheet

Teachers’
Information Panel
CHANGE YOUR
CLASSROOM
FONT HERE!

How to get your
pupils using
Letter-join at home.
Change Class Name
and Year Group of
your Classroom
account.

Instruction
Guides
l

Handwriting Lesson Planners
(PDF format)

l

Handwriting Manual for
teachers

l

Handwriting Policy

l

Font guide

l

Fonts in MS Word

l

On-line Word Processor

Letter-join

l

Setting up tablets

VIDEOS

l

Word Animator guide

l

Worksheet Generator

l

Instructions for pupils at
home

l

Handwriting Manuals for
pupils and parents

l

Left-handed Guidance

l

Handwriting Progression

Letter-join workflow: animation to worksheet

l

Handwriting Recovery

Animations for individual letters include voiced instructions
and link to an accompanying practice worksheet.

Essential videos and
presentations to help
get the most from
Letter-join.

Choose a letter to watch (font choices
available under Classroom Font options)
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Watch animations with
spoken word instructions

Touch-screen activities for
IWBs, iPads and tablets

Practice worksheets accompany
all sections
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CLASSROOM SET-UP

When using any of the Letter-join fonts in MS Word

CONTEXTUAL ALTERNATES SWITCHEDCLASSROOM
OFF
SET-UP

it is important to select the Contextual Alternates

option to correctly reproduce the cursive
letterforms
Display
cursive fonts correctly in MS Word
Letter-join cursive and printed fonts
and use the correct joining strokes.
LETTER-JOIN

Individual class fonts
Class teachers can use any Letter-join font for their
class by clicking the ‘Info’ button and choosing
‘Classroom Font Options’. The chosen font will be
used for all Letter-join activities.

Letter-join fonts: use without a download
The Letter-join on-line Word Processor is designed to
produce documents using Letter-join fonts, without
needing to download to a computer. Find out more on
page 32.

Letter-join fonts for MS Word
Letter-join fonts can be downloaded by school
subscribers from the Admin page for use in MS Word.
See ‘Installing fonts’ page 43.

Watch Letter-join Font Videos
letterjoin.co.uk/videos.html

Letter-join Plus
Letter-join Plus is a continuous cursive font
with lead-in and lead-out lines.

FONTS IN MICROSOFT
WORD
CONTEXTUAL ALTERNATES SWITCHED ON

How to switch on Contextual Alternates

About Contextualthe
Alternates
With the Letter-join fonts installed on your computer
LetterContextual Alternatives is a typographical term for
join fonts will be displayed in the MS Wordcorrectly
font list.
they
aretogether.
joining If
cursive
letters
not showing, re-start MS Word for the fontsLetter-join
to show.
font software compatibility

• In MS Word,
select Format > Font (or Ctrl D).
the dog
ran
option to correctly reproduce the cursive letterforms

Letter-join Air Plus
Letter-join Air Plus is used when wanting to teach
continuous cursive letters that are not joined.

Letter-join Air No-lead
Letter-join Air No-lead does not include a lead-in line
and the letters are not joined.

the dog
ranto betoselected
switch
ontime
Contextual
This option hasHow
every
MS Word is Alternates
re-opened
• Tick the ‘Use Contextual Alternates’ button.

Letter-join Print Plus has simple exit strokes for letters
that end ‘on the line’.

Letter-join Print
Letter-join Print matches the letter style used in
Letter-join to teach printed letters.

Letter-join Basic
Letter-join Basic is designed for use with PowerPoint
and Smart Notebook. It is based on Letter-join Plus.
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CONTEXTUAL ALTERNATES SWITCHED ON

apple

CONTEXTUAL ALTERNATES SWITCHED OFF

✘
Create a Word Template to keep
Letter-join’s font preferences
Lead-in
joins shaped
are incorrectly formed
Lead-in
line lines are missing and
Wrongly
missing
letters that overlap
CONTEXTUAL ALTERNATES SWITCHED ON

CONTEXTUAL ALTERNATES SWITCHED OFF

You can create a time-saving template to use that has
the Letter-join font selected with contextual alternates
enabled. Lead-in lines and joins are formed correctly

✔

or alternativelyWith
a Word
templatefonts
can be
created
withcomputer
Contextual
the Letter-join
installed
on your
the LetterAlternates already
selected,
asdisplayed
shown on
theMS
right.
join fonts
will be
in the
Word font
list. If theyAlternates
are
Switching
on Contextual
in Microsoft Word
Open a new Word document and select Ctrl + D.
not showing, re-start MS Word for the fonts to show.
Choose the Letter-Join font. Select the Advanced tab
Please make sure that the Letter-join fonts are
• Select text.
and enable ‘Use Contextual Alternates’ then click OK.
installed - see page 43.

the dog ran

the dog ran

• In MS Word, select Format > Font (or
D).
With Ctrl
the Letter-join
fonts installed on your
• Select the ‘Advanced’ tab.

computer open MS Word and check that the
fonts are displayed in the font list.

If the
Letter-join fonts are not listed, re-start
• Tick the ‘Use Contextual Alternates’
button.

Letter-join Print Plus

apple ✔

Lead-in lines and joins are formed correctly

As well as MS Word, Contextual Alternates is
When
using
any
of
the
Letter-join
fonts in MS Word
auto-selected by Apple Pages. For programmes that do
• Select text.
have Contextual Alternates, please use the Letter-join
it is important to select thenot
Contextual
Alternates
Basic font as shown on opposite page.

and use the correct joining strokes.

Letter-join No-lead has no lead-in line but has a
lead-out line that joins to the following letter.

Lead-in lines are missing and joins are incorrectly formed

When using any of the Letter-join cursive fonts in
Microsoft Word it is important to switch on the Contextual
Alternates option to correctly reproduce the cursive
letterforms and use the correct joining strokes between
letters. Please set-up as shown below.

• Select the ‘Advanced’ tab.

Letter-join No-lead

✘

the dog ran

MS Word.

the dog ran

• Tick the ‘Use Contextual Alternates’ button.

This option has to be selected everyHow
time
MS Word
is re-opened
to switch
on Contextual
Alternates:
• Highlight all text.
or alternatively a Word template can be created with Contextual
• Select Format > Font (or Ctrl D).
Alternates already selected, as shown
on the
right. tab.
• Select
the ‘Advanced’

the dog ran

This option has to be selected every time MS
Word is re-opened or alternatively a Word
template can be created with Contextual
Alternates already enabled.

Navigate
to Filea>Word
Save as.
In the ‘Savetoaskeep
type’ field
Create
Template
change from the default ‘Word Document (*.docx)’ to
Letter-join’s font preferences
‘Word Template (*.dotx)’ and name the file.
You can create a time-saving template to use that has
the Letter-join font selected with contextual alternates
enabled.
Open a new Word document and select Ctrl + D.
Choose the Letter-Join font. Select the Advanced tab
and enable ‘Use Contextual Alternates’ then click OK.
Navigate to File > Save as. In the ‘Save as type’ field
change from the default ‘Word Document (*.docx)’ to
‘Word Template (*.dotx)’ and nameWord
the file.
Template

LETTER-JOIN HANDWRITING MANUAL
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Distribute this file to all staff who will use the LetterWord Template

Handwriting Lesson Planners

LESSON PLANNERS

The seven Letter-join Lesson Planners provide structured
lessons for teaching printed and cursive handwriting.
To suit your school’s handwriting policy, Letter-join’s Lesson Planners offer two routes into teaching
handwriting; either printed or cursive letters in Early Years and Key Stage 1.

Lesson Planners: Early Years through to Year 6
PRINTED

CURSIVE

CURSIVE

CURSIVE

EARLY YEARS

EARLY YEARS

YEAR 3

YEAR 5

MODULE 1 PRINT
70 LESSONS

MODULE 1 CURSIVE
70 LESSONS

MODULE 4
60 LESSONS

MODULE 6
60 LESSONS

Starting handwriting with
printed letters.

Starting cursive
handwriting in Early Years.

Improve legibility,
consistency and quality
of handwriting.

Combine fluent handwriting
with other curriculum
subjects.

PRINTED

CURSIVE

CURSIVE

CURSIVE

YEAR 1

YEAR 1

YEAR 4

MODULE 2 Print to Cursive
80 LESSONS

MODULE 2 CURSIVE
80 LESSONS

YEAR 6

MODULE 5
60 LESSONS

Handwriting with printed
letters and preparing for
cursive writing.

Capital letters, printed
letters, numbers,
punctuation and symbols.

MODULE 7
60 LESSONS

Apply size-appropriate
handwriting to all areas of
the curriculum.

Develop more of a personal
handwriting style and write
with automaticity.

PRINTED

Handwriting worksheets
Letter-join Handwriting Lesson plans
progress through a series of worksheets
combining handwriting practice with SATs
revision topics for KS1 and KS2.
Lesson Planners cover each of the key
stage requirements and are written by
teachers and editors with expertise in
EYFS, KS1 and KS2.
They are developed in keeping with the
UK National Curriculum and use
Letter-join’s resources to provide a
thorough and interesting way to teach
handwriting.
How to download Lesson Planners
Letter-join Lesson Planners and their
corresponding worksheets links can be
accessed from the ‘Lesson Planners’
option on the Teachers Info page.

Early Years lessons cover all lowercase letters;
either printed or cursive fonts.

KS1 and KS2 handwriting practice includes SPaG
topics and longer passages of text.

Handwriting Recovery Programme
Designed for pupils in upper Key Stage 2
and above who require extra support with
their handwriting.

Handwriting Assessment Tracker
Provides a complete scheme to assess
pupils’ progression in handwriting skills
from Early Years to Year 6.

CURSIVE

YEAR 2

YEAR 2

MODULE 3 PRINT
90 LESSONS

MODULE 3 CURSIVE
90 LESSONS

Starting cursive handwriting
and increasing fluency
and speed.

Increase fluency and speed
of handwriting through
regular practice.

Each module has links to corresponding
worksheets.

Both can be downloaded from the
Letter-join Lesson Planners page.

Lesson Planners are provided in PDF format and can be downloaded from the teachers’ ‘Info’ page.
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Lesson Planner
MODULE 1 FOR PRINTED
OR CURSIVE LETTERS

Early Years
Foundation
Stage
Letter-join offers the option to start teaching
handwriting using printed letters, for all
resources and worksheets, before moving on
to cursive handwriting.
Patterns and pre-writing shapes can be
challenging for young pupils, but Letter-join
has all the resources needed to introduce the
different handwriting strokes.
Letter-join’s animations present pre-writing
patterns with fun sounds that can be copied
by air-writing or by tracing on IWBs, tablets
and, most importantly, by practising with a
pencil on printed worksheets.

EYFS

EYFS touch-screen activities
LetterMatch
Helps teach the names and
sounds of the letters of the
alphabet.

To complement Letter-join worksheets for patterns,
letters and words, children can choose Letter-join’s
touch-screen activities to enhance writing skills.
Use any Letter-join printed or cursive font to display
in activities.
Choose the font that’s most appropriate
for your class.

Magic Patterns
A selection of patterns, shapes and
mazes for tracing.

Magic Words
Enter any word to trace on a variety
of colourful backgrounds.

This naturally leads on to the introduction of
real letters. Watching and copying the shapes
of letters and the various joining techniques,
if appropriate, will enable pupils to learn to
write simple words at this early stage.
Letter Families
Reinforce the different letter
shapes and show children the
correct way to write the letters.

LetterMatch
LetterMatch is an activity to teach
children the names and sounds of
the letters of the alphabet.
When the sounds have been learned,
play a matching pairs game to
reinforce the learning task.

PhonicsMatch
Combine handwriting and phonics
with Letter-join’s fun, interactive
phonics resources.
10
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Ideal for children to use at home on
iPads and PCs for independent
learning. Find LetterMatch under the
‘Fun’ tab.
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EYFS

EYFS

Develop writing skills with pre-writing patterns

Letters and words made simple
Watch, practise, trace and copy –
the easy way to learn handwriting.
Letter-join introduces animations of the
letters of the alphabet in a progressive
manner starting with ‘long ladder letters’
and building up to the more complex
letter shapes.

Each letter is presented as an animation
with a spoken description.
There are also opportunities to ‘try’ letters
and words on IWBs and tablets.
Interactive whiteboard display allows for whole class involvement.

Letter-join provides a selection of fun
pre-writing patterns for EYFS pupils that
cover all handwriting movements. These
encourage fine and gross motor skills as
a foundation to handwriting.
Presented at a large scale the IWB,
Letter-join is perfect for practising gross
motor skills by air-writing the shapes.
Finer control can be gained by finger
writing on tablets or with a pencil using
the worksheets. Worksheets consist of
lines of patterns for tracing using a pencil
or crayon and a simple drawing which
can be ‘coloured-in’ using the patterns of
that group.

Each set of letters is followed by
accompanying words illustrating the
joining methods of the letters
just practised.

Pre-writing patterns cover all writing shapes.

The letter and word sets can be
printed in three different sizes for real
handwriting practice.

Watch patterns, such as jellies, with fun sounds.

Fun worksheets are available as PDFs
for all the pattern sets for handwriting
practice using pencils and crayons.

Each set of words also includes a
worksheet which models each of
the words in a sentence helping
children to understand the word
in context.

WORD ANIMATOR

WORD BANKS

Create animations
for any word

Make class word banks
To change a Letter-join font, click the ‘Info’
button on any Letter-join page and choose
‘Classroom Font Options’.

Start handwriting using
printed or cursive letters
Letter-join has now expanded to include
a new Print font and Lesson Planners
giving teachers the choice to start
teaching handwriting using printed or
cursive letters.

WITHOUT LEAD-IN LINE OPTION

Use Letter-join’s Word Animator to create
an animation of any word.
These can be saved into Word Banks for
children to use at home.

12
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CLASSROOM FONT OPTIONS

Word Banks can be easily made into spelling
lists and word searches can be accessed by
children who log-in to Letter-join at home.

Animations of letters and words and
associated worksheets are available
without lead-in lines.
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Lesson Planner

MODULES 2 & 3

Key Stage 1
Handwriting can be fun and Letter-join
will help reinforce skills throughout
KS1 with a mix of touch-screen and
traditional activities.
KS1 is the time to introduce new
letterforms including capital letters,
numbers and punctuation. To show the
correct letter construction, Letter-join
includes animations for all of these, and
provides ready-made worksheets for
labelling and form-filling using capital and
printed letters.
Key Stage 1 children should be working to
produce neater handwriting with consistent
spacing. Handwriting speed can be
improved and developed using Letter-join’s
dictation exercises.

Lets try...
KS1 SPaG Revision
Letter-join offers a series of
worksheets to support KS1 SATS
which are not only great for
improving handwriting, but are
also perfect for the revision of
spelling, punctuation and
grammar.

Teachers can set home learning tasks for
their class, and pupils can log into
Letter-join at home, on iPads and tablets,
to access the tasks and use Letter-join’s
other fun activities.
See page 42 for details.

There are many fun worksheets
aimed at boosting your children’s
confidence so they are SATs ready.
SATs worksheets can be
downloaded from Resources >
Printouts > Key Stage 1 and are
also used in Handwriting Lesson
Planner, Module 3.

14
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KEY STAGE 1

KEY STAGE 1

Developing pupils’ handwriting skills

Letter-join worksheets in
‘Resources’

For capitals, numbers and printed letters, try ‘More Letters’ for
touch-screen activities and worksheets.

Capital letters, printed letters, numbers
and symbols can be practised using real
handwriting on the many worksheets
provided in ‘Resources’.
For the complete listing of printout
sheets, Letter-join users can visit
Resources > Printouts. See page 24.

Reach Key Stage 1
handwriting
standards
• Demonstrate the correct methods
for writing upper and lower case
letters with the correct joins.

• Show how to form numerals of
the same size that sit on the
base line.

Practise number writing

Introduce form-filling

Letter-join includes a full set of times
tables worksheets, up to 12 x 12, which
are great for practising number writing.
They are provided in look, trace and copy
format.

Pupils can learn how to write within the
constraints of a form using printed and
capital letters. Letter-join includes a
selection of forms for Key Stages 1 and 2.

• Teach how to write printed letters
and use Letter-join’s animations
and worksheets to practise how
they are used.

Magic Words, in the ‘Fun’ section, can also
be used to practise number writing.

Capital letters

Numbers and symbols

Letter-join’s animations teach
how to form capital letters
correctly. To accompany
teaching, there are Letter-join
worksheets specifically for
practising capital letters e.g.
writing names, form-filling,
crosswords and word searches.

Touch-screen activities can be
used for immediate practice of
numbers and symbols. For real
handwriting practice there is
varied and interesting selection
of worksheets.

• Ensure that pupils know how
much space to leave between
words.
• Encourage pupils to write longer
passages of text to build up
endurance using the Dictation
Exercises.
• Use Letter-join’s worksheets to
ensure that letters sit on the
base line and are consistent in
size with correctly formed
ascenders and descenders.

Printed letters
KS1 activities for practising
printed letters include labelling
diagrams, writing email addresses
and worksheets that include a
mixture of printed and capital
letters, for instance when
addressing an envelope.

16
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KEY STAGE 1

KEY STAGE 1

Letter-join’s Magic Words – touch-screen activities
Magic Words is a great way for KS1 pupils
to type in their own words and practise
their handwriting using the touch-screen
capabilities of iPads and tablets. Class
teachers are able to select the Letter-join

font they wish their pupils to practise
with. There are five exciting, colourful
backgrounds and a simple star reward
function, which pupils will enjoy using on
their tablets at school and at home.

Help pupils become familiar with similar letter shapes and
become confident at writing differently formed characters.

Practise speedy writing with Dictation Exercises
Letter-join’s Dictation Exercises are a great
way to introduce speedy writing and help
build up stamina.

Dictation Exercises help with children’s
listening skills and in learning how to
revise and edit their writing.

Try Letter Families worksheets
and touch-screen activity

The dictation exercises for KS1 start with a
simple spelling list, a list of 2-digit
numbers and an easy poem.

Using the familiar format of long ladders, curly caterpillars,
one-armed robots and zig-zag letters, Letter-join’s Letter Families
worksheets can be printed out for tracing and copying.

To strengthen letter formation and to learn which letters belong
to each family, try the Letter Families touch-screen activity, under
the ‘Fun’ tab.

Handwriting worksheets

SPaG practice worksheets

Handwriting and spelling go together and Letter-join provides
many spelling worksheets for practising handwriting.

A series of worksheets which specifically cover spelling,
punctuation and grammar practice. As well as providing excellent
revision and homework sheets, the printouts also provide plenty
of handwriting practice. KS1 worksheets are available with
printed or cursive fonts.

These include: pangrams, high frequency words, cloze sentences,
word spacing and joining techniques. See pages 26 to 28 for
more worksheet examples.

Prepositions presented with
colourful graphics

Spelling worksheets include all
the long vowel sounds

Sequencing sentences with
guidelines for handwriting practice

A dictation list written out as a first draft and a final copy.
See page 30 for more information about Dictation Exercises.
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KEY STAGE 2

Lesson Planner

MODULES 4 to 7

Key Stage 2
Ready for the final round of handwriting
challenges? When pupils master these they’ll
be true handwriting champions!
Building on KS1 skills, pupils will be writing
passages of text neatly and speedily, labelling
diagrams using printed letters appropriately
and filling in forms using legible writing.
Letter-join’s KS2 teaching resources will help
pupils acquire a feel for neatness and quality
in their final handwritten work. Audio dictation
lessons (see page 22) will develop handwriting
stamina when writing.

Let’s try...
Practise topic spellings using
the Word Animator and the
On-line Word Processor
Build animations of words for whiteboard and tablet
practice and send to the Letter-join Word Processor
to create ‘look, trace and copy’ spelling lists.

1
Build a bank of animated topic
words for pupils to re-play and
trace using the Word Animator.

2
Share classroom Word Banks
with pupils to watch and
practise.

KS2 home page with quick links to a range of resources.

Log in to Letter-join as a Key Stage 2 class
(see ‘Classroom Options’ on page 4) and
Letter-join will display a page of links to a
range of resources specifically for KS2. This
includes quick links to Lesson Planner
worksheets and the Handwriting Recovery
programme, and direct links to categorised KS2
worksheets and resources.
With the support of Letter-join, pupils will
have covered all the criteria necessary by the
end of Year 6 to reach the standards set out
in the National Curriculum for handwriting.

20

3
Choose to make a spelling
list or word search to extend
Word Bank activities.

See page 32
for details of
the On-line
Word Processor
and page 34
for details of
the Word
Animator.
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KEY STAGE 2

KEY STAGE 2

Accomplishing neat handwriting
Introducing Letter-join’s advanced handwriting exercises
to reach KS2 National Curriculum standards.
Challenging dictation
exercises for KS2
These exercises will help with stamina,
speedy note-taking and encourage
proof-checking and editing.

Extract from
Hansel and Gretel

Write in Time!
A handwriting activity for Key Stage 2
children that provides the opportunity
to practise fast and fluent handwriting
which is neat and legible. To play the
game, children choose from eight
familiar KS2 topics. The more words
that are neatly written, the higher the
award given.

...it was built of
bread and covered
with cakes...

The National Curriculum
tasks Key Stage 2 pupils
with aiming for quality,
speed and stamina.
Letter-join’s resources will help
to attain this target and provides
worksheets and exercises to help
improve handwriting.
The National Curriculum criteria for
KS2 handwriting includes:

Quality:
Ensure that letters are of consistent
size with equal word spacing and
that ascenders and descenders
are parallel and do not interfere
with the writing on the above or
below lines.

Speed:
Improve speed of handwriting
to allow creative writing to take
precedence over the task of
handwriting and be able to take
‘quick notes’ at a faster pace.

Stamina:

Curriculum topics
Letter-join provides opportunities to link handwriting practice to other areas of the
curriculum and combines handwriting practice with other KS2 tasks such as statutory
word lists.

Have the strength and mobility to
be able to write for longer periods
of time without fatigue.
Pupils are expected to have full
knowledge of different kinds of
handwriting for different purposes
including:
• Neat, joined, cursive letters for
writing passages, large amounts of
text, lists and letters.
• Printed or capital letters for
posters, presentations, headings,
labelling and form filling.
• Speedy handwriting for notetaking and dictation where
neatness is not as important and
shortcuts can be used, such as ‘+’
instead of ‘and’.
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Resources

RESOURCES

Letter-join resources include hundreds of printouts,
and tools to help you create your own content. Create
spelling lists, word banks and posters, all of which
can be saved and shared for future use.

• Printout sheets

• Dictation Exercises

• Word Animator

• Warm-up Exercises

• On-line Word Processor

• Worksheet Generator

		

		
Page 32

On-line Word Processor

Printout Sheets

Pages
26 to 28

Letter-join includes hundreds of worksheets divided into five
sections which can be printed with your choice of font and use
a school’s chosen alternative letterforms.

Create and save documents using any
of the Letter-join fonts.
An on-line alternative to MS Word for creating
spelling lists, classroom presentations and
much, much more! The on-line Word Processor
does not require Letter-join fonts to be
downloaded onto computers.

Find on-line in Resources

Warm-up Exercises
Develop gross and fine motor skills.
Pupils will enjoy Letter-join’s fun warm-up
exercises for gross and fine motor skills.
They can be found in the Letter-join Lesson
Planners and on-line under Resources.

		

		

Page 29

Page 30

Dictation Exercises
Improve listening skills as well as
handwriting speed, accuracy,
note-taking and editing.
Key Stage 1
• A selection of CVC words, a list of numbers and
an easy poem.

Word Animator
Page 34

TYPE A WORD

2
CREATE
ANIMATION

3
BUILD A
WORD BANK

Create handwriting worksheets for spelling
lists, sentence sheets and posters.
Choose any of the Letter-join fonts to produce
worksheets. Worksheets are created within internet
browsers and your school’s choices of preferred
letterforms will be used. They can be saved as
PDFs for future use.

• Harder dictation exercises: a list of phrases,
easy additions and a three-verse poem.

Create animations of words to save into classroom Word Banks.

1

Worksheet Generator

4
PRACTICE
FOR PUPILS

• Sentences and paragraphs using years 1 and 2
common exception and high frequency words.

Key Stage 2
• More challenging exercises: a shopping list,
complex numbers and a longer written passage.
• Dictation exercises using extracts from
traditional stories and poems.

24
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RESOURCES

Font style

Printouts

All printouts are available
in two font styles:

Letter-join includes hundreds of printouts using
your choice of font and alternative letterforms

• WITHOUT lead-in lines

SPaG worksheets
A growing series of worksheets combining handwriting practice with KS1 and KS2 SATs revision.

• WITH lead-in lines
Early Years and KS1
printouts are also
available in the print font.

Handwriting worksheet examples
High frequency words
100 high frequency words to trace
and copy for EYFS and KS1 in
large, medium and small sizes.

Spelling lists and sentences

Punctuation

Grammar

Practise spelling rules and patterns with
trace and copy word lists then reinforce
with complementary ‘missing words’
worksheets.

Punctuation practice in the context of
meaningful sentences. Worksheets cover
all the punctuation requirements.

A series of exercises covering the grammar
topics required for KS1 and KS2 SATs such
as adjectives and prepositions.

MFL worksheets

Word lists

Cloze exercises

Worksheets combining handwriting practice
and French/Spanish vocabulary.

Spelling words, as listed in the DfE’s English
Programmes of Study in look, trace and
copy format.

Missing words sentences using words
from the word lists for Years 3-4 and
Years 5-6.

Letter families
Colourful worksheets to help with the different families of letter shapes.

Sequencing sentences
Write sentences in order to form
short narratives. Two different
levels for years 1-2 and years 2-3.

Pangrams
Worksheets to consolidate correct letter formation using
sentences that contain all the letters of the alphabet.
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RESOURCES

Numbers, Capitals and Printed
Letters worksheets
Labelling exercises
A selection of worksheets for practising printed letters,
covering curriculum-based topics for all key stages.

RESOURCES

Posters and Handouts

Worksheet Generator

Alphabet printouts
A4 printouts for cursive, printed and capital letters which
will print using your school preferred letterforms for f, k, w,
x and z. These are useful for sending home so that parents
know which letterforms are used at school.

Create your own handwriting worksheets
for spelling lists, sentence sheets and posters.
Each classroom account can choose
any of the Letter-join fonts to produce
printouts using the Worksheet Generator.
Worksheets are created within internet

browsers and your school’s choices of
preferred letterforms for f, k, w, x and z
will be used.

Worksheet
Generator
Hints and Tips
Changing the font
You can quickly change the font
via the ‘Info’ button and choose
‘Classroom Font Options’.

Times tables worksheets
Trace and copy worksheets for tables facts to 12 x 12.

The font is not joining correctly
on the Worksheet Generator.
Do not use Internet Explorer
for Letter-join! The Worksheet
Generator will produce fonts
correctly if using Google
Chrome, Firefox or Safari.

Alphabet banners

PRINTING WORKSHEETS

All the letters of the alphabet, each on an A4 sheet, to print out
for displaying in the classroom or for pupils to colour in.
Available as cursive, capital and printed letters.
Spelling Lists

Sentence Sheets

Posters/Freestyle

Microsoft Word templates
Designed to match a standard handwriting book style. Choose
from four sizes.

The worksheets are printing
very faint and the guidelines
are not showing.
Some laser printers can
struggle to print from a web
page. Save the worksheet as a
PDF (see above) and print from
the PDF.

Form-filling exercises
A series of form-filling exercises for all key stages to help teach
the formation of printed and capital letters.

In three sizes with options to
show all the guidelines or the
baseline only.

In three sizes with options to
hide or show guidelines and
with trace or trace and copy
options.
In three sizes with options
to show guidelines, baseline
only or no lines at all, and
to range text left or centred.

Highlighted writing paper
Choose from three different line widths.
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A4
HIGHLIGHTED
PAPER
Choose from 3
different line
widths

How do I save worksheets
created using the Worksheet
Generator?
The Google Chrome browser
has a facility to save pages
as PDF files. Create your
worksheet as normal using
Google Chrome and select Ctrl
P then change ‘Destination’ to
‘Save as PDF’.

The tracing words are printing
in black when I generate a
worksheet.
If using Firefox, to print the
tracing words in grey please
select the ‘Print Background’
option from Page Setup.
Firefox: File > Page Setup > tick
Print Background.
The lines are over-running when
I print a generated worksheet.
We recommend a maximum
number of letters/words/lines
for each character size on
the Worksheet Generator. If
exceeded text lines may overrun. Try reducing the number of
words per line.
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RESOURCES

How to use Letter-join Dictation Exercises

Dictation Exercises to speed up handwriting

A slippery floor

Increase the pace of children’s note-taking
Letter-join’s dictation exercises are a
collection of recorded texts and
accompanying support text, especially
written to improve listening skills and
increase the pace of children’s note-taking.

Letter-join’s fun dictation exercises for Key
Stages 1 and 2 cover common exception,
high frequency and statutory words. They
are simple and fun, and can be practised
at school as well as at home.

Dictation is a very good exercise to build
proficiency and speed in handwriting
as well as supporting spelling and
editing skills.

The exercises start with simple CVC words
and progress through to longer passages
of text to help build stamina and
automaticity in handwriting.

1
2
3
4

1 Listen
Click ‘Play’ on the ‘Listen’ row to play the
dictation exercise at normal speed for the
class to hear. This is to allow pupils to
become familiar with the dictation they are
about to write.

3 Edit
Play the Edit recording which is at normal
speed. This will allow pupils to fill in any
blanks they have left, or to make changes.
You can play this more than once, if
necessary.

2 Write
Press ‘Play’ on the ‘Write’ row for pupils to
listen to a slower version of the recording,
pressing ‘Pause’ between phrases to allow
time for pupils to write what they hear.

4 Write out again
Click the link to display the written text
so that pupils can check their work before
writing out again using their best joined-up
handwriting.

Explain that if they do not hear clearly, or
if they don’t have time to write everything,
they can leave a blank space which can be
filled in later at the ‘Edit’ stage.

A typical Key Stage 1 dictation exercise using simple sentences

A selection of CVC
words, a list of
numbers and an easy
poem.

A list of phrases, an
easy number sentence
and a three-verse
poem.

Years 1 and 2
common exception
and high frequency
words.

A shopping list,
complex numbers and
a longer written
passage.

Longer passages
using extracts from
traditional stories and
poems.

Dictation sound file for class to listen to.

Children listen to the passage and
write down what they hear.
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PDF for teachers to display for
checking.

A Key Stage 2 dictation exercise, using a traditional story, with a longer passage of text

Dictation Exercises are found under the Resources tab.

KS1 dictation exercises use common exception and high frequency
words in sentences and paragraphs.

Pupil’s written text.

The whole passage can be displayed on the whiteboard
for children to check their work.

The first set of KS2 dictation exercises cover a mixture of numbers
and words.
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RESOURCES

Letter-join On-line Word Processor

Make a spelling list with the Letter-join on-line Word Processor

Create instant spelling lists, and more, on-line.

Letter-join
On-line Word
Processor
displays cursive
fonts correctly.

1

Open the Letter-join
On-line Word
Processor from the
Resources tab.

Log in and start
designing – no need
to install fonts!

Click ‘File’ from within
the Word Processor
window and select
‘Open’.
Choose ‘Look, trace and
copy Spellings’ from the
‘Templates’ section.
Other templates are
available.

The Letter-join On-line Word Processor allows you to create
and save documents using any of the Letter-join fonts with a
school’s pre-selected letterforms.
Use to create worksheets, posters and notices when using a
computer that does not have the Letter-join fonts or
MS Word installed.

How to use
Log in to your Letter-join classroom account,
select the ‘Resources’ tab and choose ‘W
Processor’. You can either start typing
to create a new document using familiar
commands, or open any of the ready-to-use
template files to overwrite with your own text
and images.

Opening, saving and printing documents
Please use the ‘File’ option
on the menu bar WITHIN the
browser window to open, save
and print documents. Do NOT
use Ctrl-S or File > Save etc. on
your computer’s menu bar.

2

Scroll over the heading to select ‘Spellings title’ and
overwrite the heading for your spelling list.
Continue until the table is complete.

3

Once the list has been created, select all of the text to
change it to your preferred font.

7

Ready-to-use Letter-join templates
The Letter-join Word Processor includes a growing number of templates
including lined and highlighted paper, Spelling List and Year 2 Common
Exception words for classroom display. Staff can customise templates
on-line by typing new words and choosing any Letter-join font.

6

Scroll over ‘Insert date’ and overwrite the date or select
an option from the pull-down menu.

4
You can save your worksheet using ‘Save’ at the top left
of the Word Processor.
Place your cursor in the cell underneath Look, and type your
first word. The ‘Look’ text will be black.

As well as each classroom’s
saved documents, Letter-join’s
templates and examples can be
opened and edited.

8
5

Documents are saved for each
classroom account.
When printing, ensure that ‘Print
background images’ is selected
to print worksheets correctly.

Now place your cursor in the cell underneath ‘Trace’,
or use the Tab key, and type your first word again. The
‘Trace’ text will be grey.

You can print directly to your printer or you can save
as a PDF by changing the destination of the printer to
‘Save as PDF’.

‘Look, trace and copy’ spelling list
Instructions can be found under the Info button.
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RESOURCES

Show Pupils how to access their classroom’s Word Banks

Word Animator
and Word Banks

Word animations that are produced by a class teacher can be watched and practised
at school and at home on IWBs, iPads and tablets.
1 Log in to Letter-join

5 ‘Watch’

Use the Pupil Accounts log-in on an iPad or tablet to log in,
and select the correct classroom name.

Create animations of
words for classes to
save and replay.

Choose ‘Watch’ to see the word being written
on the whiteboard or tablet. Playback can be
Freehand or Controlled.

Teachers can create animations of project words.

For Teachers - how to create animations to share with pupils

2 Select ‘Fun’
From the Letter-join menu
choose Fun and then
Word Bank.

Create animations of words to save to class Word Banks

6 ‘Try’
Choose ‘Try’ to practise writing
words on a whiteboard or tablet.

3 Choose

1

Select ‘New Word Bank’ or
choose an existing Word Bank
from the pull-down menu.

2

Choose ‘Add a Word’ and enter
a word. Click ‘OK’. You must
write over the word to be able
to save it.

Using class Word Banks

3

Trace over the word slowly and
smoothly. If necessary, you can
erase and start again.

4

Press ‘Save’ to add the animated
word to the Word Bank.

Select a Word Bank from
the pull-down list.

Word Bank activities
Using Word Bank Activities

4 Select a word
Select a word, either on-screen or from the pull-down menu,
to watch and practise.

• Create unlimited Word Banks, for example, of topic words, 		
spelling lists or children’s names.

From the ‘Activities’ tab teachers can make spelling lists or word
searches using the Word Bank words:

• Ready to use Word Banks (including common exception words)
are pre-installed.

• Automatically produce look, trace and copy spelling lists by
selecting the ‘Make Spelling List’ option. Change the font to the
one you prefer.

• Children can access their classroom’s Word Banks at school on
a whiteboard, or at home on tablets – see opposite page.

• Make an online word search using the Word Bank words by
selecting the Word Search option from the Activities tab.
The Word Search can also be printed out.

Pupils can choose to make any Word Bank
into a spelling list or word search.

Set-up Letter-join for children to practice at home
Letter-join includes a home log-in instructions
letter for parents. See page 42.
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Fun activities
Colourful, handwriting activities for IWBs and tablets.
Write in Time!
A Key Stage 2 activity to practise fast and fluent handwriting.

Magic Patterns
A selection of patterns, shapes and mazes
for tracing on imaginative backgrounds.

PhonicsMatch

Choose from eight KS2 topics. The more words that are neatly
written, the higher the award given.

Write it Right!
A fun activity that rewards
good handwriting!

Write it Right! selects groups of
pictures with words (easy, medium
and hard) for children to trace.
The activity has accompanying sounds
and fun animations to encourage
children to play and practice their
letter shapes over again.

To start Write it Right!, enter a name
and then neatly trace over the
lettering.

Completed handwritten words
are then displayed with an
audible cheer.

A matching pairs game to beat the clock
using cursive or printed letters.

Letter Families

Magic Words

LetterLotto

Reinforces different letter shapes and shows
the correct way to write the letters.

Enter any word and trace on a choice of
colourful backgrounds.

Practise recognition and orientation
of cursive or printed letters.

Word Search

Write it Right!

Phozzle

Create class word banks to make
word searches or spelling lists.

A fun activity that rewards neat
handwriting.

Practise phonemes and graphemes to
reveal an exciting picture.

Children can print their
handwriting results or
return to the activity to
have another go.
Write it Right! includes
three levels to practice.

Classroom font options

SoundMatch

LetterMatch

A matching pairs game for Early Years
to support Letter-join Phase 1 Phonics
activities.

Helps teach the names and sounds of
the letters of the alphabet.

Class teachers can choose which
font to use for Letter-join
activities, and the same font will
be displayed when children log in
home.

Fun Activities

Children choose a picture, trace over
the word and are rewarded with stars.

From the Letter-join menu find the
‘Fun’ tab to access Letter-join
activities.
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Letter-join Phonics

FUN ACTIVITIES

Combine handwriting with phonics
in an easy and seamless way.

Word Search
Letter-join’s Word Searches are designed for iPads and tablets.
They are both fun and practical, reinforcing spellings and are
easily printed for handwriting practice.

Letter-join Phonic resources encompass Phase 1 to 5.
Teachers can display pictures of each phoneme or
grapheme on the whiteboard and the class can hear
them and watch them being written.
Children can practise tracing the phonemes and
graphemes on whiteboards or tablets and then play
the Phonics Match game.
Schools can choose from any of the Letter-join fonts
for the words which accompany the phonemes and
graphemes.

Phonics Phase 5

A4 Word Search printouts
using words from Phonics
Phases 2 to 5.
Letter-join Word Searches include a variety of words from CVC
through to some of the statutory ‘tricky’ spellings.

Make Word Searches from Word Banks
Word searches can be automatically made from any of Letter-join’s
pre-installed Word Banks or from a classroom Word Bank that has been
created by a class teacher.

The phoneme or grapheme is displayed along with a picture
of the word with the phoneme or grapheme highlighted.

Phonics posters for
classroom display

1. Choose a class Word Bank

2. Select ‘Make Word Search’
from the ‘Activities’ tab.
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Handwriting practice of the phoneme or grapheme can
be on IWBs, iPads or tablets.

To support phonics learning even further, there is a fun
matching pairs game where children can test their memory
powers against the clock!

Phonics posters can be printed out
for class displays using your
preferred font and letterforms.
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School Administrator Page
Log in to Letter-join with your School
Administrator details (sent to you by email)
to access your school’s Administrator Page,
shown below.

As a first task please give your staff their
individual usernames and passwords from
the Classroom Teacher Accounts panel.

The School Administrator Page allows you
to change preferred letterforms for your
school, download the Letter-join fonts and
add class names and year groups.

ADMINISTRATOR SET-UP

Left hand menu

Account Information

Content here can only be
accessed by logging in
as School Administrator.
The Administrator can
choose preferred
letterforms, download
the fonts, the
Handwriting Policy and
other useful information
as shown below.

Choose alternative letterforms

Left hand
menu
Please see
opposite page.

School details

This is where to select your
school’s preferred letterforms for
cursive f, k, w, x, and z and
printed f and k.

Your choices will be used across
all of your classroom and home
accounts and other Letter-join
resources.

Please check all details
are current, and update
if necessary.

Home instructions

Download Letter-join fonts
(School subscriptions only)

Tablet Edition

Print

Tablet log-in details
for pupils to use at
school and at home.

Pupil log-in

Pupil Account

See page 42 for instructions for
pupils to log in to Letter-join.

PC log-in details for
children to use at
school and at home.

Classroom Teacher
Accounts

Change the Year Group for
each class. Letter-join will then
display an opening page of
targeted resources.
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Print Plus

Air Plus

Letter-join Plus

How to distribute
passwords for your pupils
to use Letter-join at home
See page 42

No-lead

Air No-lead

The Letter-join fonts you
download will use the alternative
letterforms, chosen by your
school. See page 6 for more
information.

School Handwriting Policy
School subscribers to Letter-join can download an editable Microsoft
Word document of the Letter-join Handwriting Policy.

Please give your staff their
individual usernames and
passwords.
We recommend that class
names are changed to your
real class names. This helps
pupils easily identify their class
when logging in to their Pupil
Accounts.

abc

Lost passwords
School Admin
Email us from a school
email address:
info@letterjoin.co.uk

Classroom Account
Staff requiring classroom
log-in details should
contact their school’s
Letter-join Administrator.
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ADMINISTRATOR SET-UP

Access for
pupils

Home
Learning

Pupil log-in details

Home Learning Tasks

Log-in details for pupils to log in to Letter-join at school and
at home are listed on your school Letter-join Admin page.

Click the ‘Set Home Learning Tasks’ button from the
Teacher’s ‘Info’ page to create a class task.

There is a username and password to log in on PCs and and
username and swipe code to log in on iPads and tablets.

Installing Letter-join fonts on PCs and across networks
The Letter-join fonts can be downloaded by subscribing schools by
logging in to Letter-join as a School Administrator and following
the instructions below.

4. To download the fonts please accept the Terms and Conditions and
click on one, or each of the font name buttons, as shown below.

IT technicians and class teachers can also download the Letter-join
Font Guide from the Info page for more information about
installing and using Letter-join fonts.

Installing fonts on individual PCs

Issuing passwords to children for using Letter-join at
school and home.

1. From the Letter-join home page, log in as
Administrator on your desktop computer.

Log in to Letter-join as ‘School Administrator’ and select ‘Home
Instructions’ from the left hand menu. Open the link to the MS
Word Document letter and insert Pupil log-in details where
indicated. These can be found on your Letter-join Admin page.

Font download options from the Administrator page.

The Letter-join Home Instructions letter

Letter-join desktop log-in.
2. Select your school’s preferred letterforms
before downloading the fonts.

5. Locate where the fonts have been downloaded
on your PC to install.
The fonts are named Letter-join Plus, Letter-join Air Plus,
Letter-join No-lead, Letter-join Air No-lead and Letter-join Print,
each followed by a number relating to your choice of letterforms.
6. Right-click the file and choose the ‘Install’ option.
Restart MS Word so that the font is recognised.
The font is now ready to use in Microsoft Word and other
applications that support Contextual Alternates.

Installing fonts across networks

Choosing your school’s preferred letterforms.

Home Learning Packs
There are two sets of home learning packs for each
year group. Ideal for when children work from home.
They can be found on the Teacher’s Info page.

3. Select ‘Download fonts’ and follow instructions.

Letter-join fonts can be distributed and installed onto classroom
PCs and laptops across a school network.
Please consult your IT technician to distribute the fonts using the
MSI installer option from the link on the Letter-join ‘Download
fonts’ page.

‘Download fonts’ is in the left hand menu.

The completed MS Word document can be printed onto
a school letterhead or pasted into a school newsletter
so children can use Letter-join at home.

Setting up Letter-join for LearnPad
Access to Letter-join through LearnPad:

Naming your classes on the Admin page

• On your PC log in to LearnPad.

To allow pupils to access resources created by their class
teacher, please see how to change class names on your
Letter-join Admin page (see page 40 for details).

• Log in to Class Connect.
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• Choose ‘Content’.
• Search for keyword ‘Letterjoin’.
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www.letterjoin.co.uk
info@letterjoin.co.uk

See inspiring school Letter-join
handwriting examples on Twitter.

#letterjoin
Follow us on Twitter!
Download and print further copies
of this manual at www.letterjoin.co.uk/manual.pdf
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